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Getting Started with TwixI

Twixl Publisher consists of several components:

1. Twixl platform: an online platform where you'll manage your app and where youll
handle the content for your app.

2. Twixl app: install this app on your mobile device and you can scan the QR code of
your app. This great tool allows you to experience the complete look and feel of
your app while building it.

3. Twixl macOS app: when your app is ready, then build your app on a Mac with Twixl
Publisher and start spreading the news!

Twixl Publisher has a lot more to discover. With our InDesign plugin you can export
your InDesign files ready to import them on the Twixl platform. With the Twixl macOS
app you can preview your app in our built-in simulator or on the device of your
choice with the Twixl Viewer Classic app. You can even share this with other people
to review your app before it's published on the App Store or Google Play Store.

This ‘Getting Started’ guide is intended to help you understand the basic concepts of
Twixl Publisher and to learn how to create your first Twixl app.

Every Twixl app starts on the Twixl Platform. That’s why you need a Twixl account so you
can be in full control of your app.

Don’t have a Twixl account yet? No worries, you can create one here. It's totally free and
grants access to our Twixl platform and much more.

Twixl account ready?

+ Go to platform.twixlmedia.com
+ Login with your Twixl account

Let’'s add your first app to the Twixl platform.

« On the Twixl platform, Log in
« Click ‘Add Application’ (top right corner)

If you have a trial account, you can select the kind of app you want to add:
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1. Getting Started App: Select this one if you are looking at Twixl for the first time and we
will show you some cool features.

2. Kiosk App: Mimics a traditional kiosk with different magazines.

3. New App: confident enough to start from scratch with your own design?

Note that the Getting Started and Kiosk app are meant to be used only for testing
purposes.

Home » Application Type

Application Type

o—

New App Getting Started App Kiosk App
An empty article-based app Contains sample content Contains sample content

more info more info

Cancel

Next, select whether you want to publish the app in a testing or production environment.
Let’s go for safe and select ‘Development'’.

The last step is to identify your app.

+ Give it an ‘Application Name’”: How do you want to search for it?

+ A ’‘Bundle Identifier this is a reverse DNS name. More info on what this is under the
text field on the platform.

« If you wish you can add some metadata and an app icon. You can also provide other
people access to your application. These last fields are not mandatory and we will
skip them here.

+ Click ‘Add’ and your first app will appear on the Twixl platform!

Now that your app is on the Twixl platform, you can already preview it as is in our free
Twixl App.

Install and use the Twixl App:

« On your mobile (phone or tablet), download the “Twixl” App from the App Store or
from the Google Play store
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» Open the Twixl app, then scan the QR-code for your app on the Twix| platform, and

you can check the preview

If you selected one of the sample apps, then you are done. We already inserted some

cool features in the app for you.

Learn more about these features and what you can build yourself next time:

1. Content Items: different types of content that you can add to the app, e.g. interactive
InDesign articles, HTML-based articles, a PDF document, and much more. Learn all
about it in Working with Content Items.

2. Collections: a group of content items, e.g. a monthly magazine is a collection of
different articles. For more information on configuring your collections, please

check Working with Collections.

Now that your app has content, we can take a look at the design of the app itself in the

next step.

The way your app will look will be determined in this section.

If you have used one of our 2 sample apps then all the work has been done for you
already. Let's walk through each of these items below..

TI..I.IIXL DISTRIBUTION PLATFORM

Edit Application

Root Collection

Projects > Getting Started with Twixl Hamburger Menu

Content Items

X Application Home

GETTING STARTED WITH TWIXL | DEVELO .
Grid Styles

Item Styles

App Key
76d7135e6fc18ce279e0dco0d300 "5 PO
Content Sources
Content Templates

Application Name Getting Started with TwixI
. Subscriptions
Entitlements Mode No Entitlements
Push Notifications

Subscription Type No Subscripti
ubscription Type No Subscriptions Entitlements

Browser Client Enabled
Edit Settings
Launch Browser Client

Browser Client Settings

Launch Browser Client

Build Settings
Special Collections )
API & Integration

Title Delete App...
‘ / Root Collection
| The root collection of your app

Hamburger Menu
The collection holding the items for the hamburger
menu

f Main + [@ Reports ~

Unassigned Content Items

Collection Background Images

® @~ &~

Search collection Search

Share App Copy To Production

Duplicate App Edit App

Bundle Identifier
m. twixmedia.gettingstartedwithtwixl

ralytics Key i0S -

ics Key Android -
Created On 2021-02-19 10:59

Include
unpublished articles

Twixl ID 27942

Items Grid Style
6 BROWSE - GENERAL
" HB - GENERAL

The dropdown menu lists a lot of options. Here are some examples that have an impact

on the look and feel of your app.

Getting started
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1. Grid Styles

+ Select ‘Grid Styles’ from the dropdown menu.

+ Select ‘Default’

+ Now adjust the displayed items. You can use this Grid Style ‘Default’ later on in your
app. Learn more about Grid Styles here.

Update Grid Style: Default
1 CELL APP | DEVELOPMENT MODE
TABLET | PHONE | BROWSER

Metadata

Default

Structure

4 Vertical %

Padding

10 pt 10 pt 10 pt 10 pt

Spacing

10 pt

m Save & Continue Cancel

A

+ Metadata: can be used for referencing afterwards.

+ Structure: adds the number of columns in your grid style. E.g. a grid of 4 columns will
position your collections 4 in a row.

« Padding: will insert more space between your collections and the bezel of the device.

+ Spacing: defines the space between each of your collections.

« Colors: be creative and give your background and text a distinct unique color.

+ Background Image: by default the background will be a single coloured frame. You
can, however, also select a background image that you've uploaded.

 Allowing horizontal swiping and displaying scrollbars are the last options.

About Grid Styles:

Grid styles determine how your Browse Grids will display the collections in your app on
different devices. You can define different Grid Styles for tablets, phones or the browser.
Learn more about Grid Styles here.

2. Item Styles

The appearance of the cells in your browse grids can be determined in ‘Item Styles'.
While a ‘Grid Style’ applies to a collection, an Item Style" applies to a content item.

» Open the dropdown menu
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+ Select ‘Item Styles’
« Click on ‘Default’

X Update Item Style: Default

APP WITH MONOLITHIC COLLECTIONS | DEVELOPMENT MODE
TABLET | PHONE | BROWSER

General Options

Metadata

Metadata & Info
Default
Cell Layout

Default
Table of Contents |
Image Layers (1/1) Info

Image Layer

100021917

Text Layers (2/2) {title} {icon-download-status}

Text Layer

20264e12ae1836d11987f39789d9ad5f

{title}
Add Text

Text Layer

The sidebar on the left determines the options in the right side bar. The image in the
middle provides a preview of how the content item will be displayed. The image is built

up by layers of image and text and you can design these layers to give it a unique
appearance.

Again, these Item Styles can be different for tablets, phones or the browser.
To learn more about ‘Item Styles’, check this article.
Integrating the styles in your app

Now these default Grid and Item Styles have been defined, you can apply them the
collections in your app.

+ Go back to Home of your app
« At the right of Root Collection, select ‘edit’
+ In‘Styling’ select ‘Default’ in the dropdownmenu next to ‘Grid Style’ and ‘Item Style’
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‘ X Update Collection: Root Collection

APP WITH MONOLITHIC COLLECTIONS | DEVELOPMENT MODE

Collection Details

Name * Root
Title Monolithic collections
Published On 01/02/2021 10:18
This is used to determine if a collection is part of a subscription or entitlement.
Styling

OpenIn* Browse Mode v

Grid Style * Default v

Default Item Style Default v

Sort Mode Publish Date, most recent first -

This means you can have all kind of unique Grid and Item Styles and give them
distinctive names so you can select them in this section too.

About Root Collection and Hamburger Menu...

Consider the Root Collection as the home screen of your app. The Hamburger Menu
collects the menu options in your app. You can activate or deactivate this menu.

Previewing your app is the next step. It's the very beginning of your testing process. We
offer an easy way to preview your app on mobile devices or in an iOS Simulator (on a
Mac)! The following articles will help you to get started:

1. Preview an app on a mobile device
2. Preview an app in the iOS Simulator

3. System Requirements
4. Downloads

The last step is to build a real iOS or Android app. During testing you can start with a
Development version and in the end you turn it into a Production app. The process to
build the app is the same in both cases.
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+ Getting started with the Twixl macOS app

¢ WHAT'S NEXT?

If you master these basic skills, you can dive further into the world of Twixl
Publisher. Don't forget that this site contains a lot of extra information, covering
more advanced topics as well!

Getting started Page 10
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Sample App 01: Getting started

This article explains the concept behind our Getting Started app.

The
library

The purpose of this sample app is to demonstrate some of the things that are possible
with Twixl Publisher, to get you started and to make sure you understand the basic
workflow. The app is meant to just give you an impression, it is neither a real nor a
finished project. It's a basic app with the three main types of content (InDesign-based,
HTML and PDF), a Hamburger Menu and support for the Browser Client, next to iOS and
Android.
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A LEGALINFO:

This app and its contents can be used for demonstration purposes only. It
cannot be used for other commercial purposes without prior consent from Twixl
media bv.

- Disclaimer
+ General Terms & Conditions

¢ ABOUT SAMPLE APPS:

Please remember that you can play around with Sample Apps. In other words:
the default settings can always be changed!

It has a Hamburger Menu
« It has a Browser Client activated

« It has different Browse Grids & Iltem Styles

« It has mainly 3 types of content: Twixl articles (InDesign-based content items), HTML
articles, PDF content items.

« It supports downloading of content for offline access.
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https://twixlmedia.zendesk.com/hc/en-us/articles/115000718185-working-with-content-items
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Twixl Publisher Getting Started

QrunXL SAMPLE APP
@

Getting started

.

Indesign baged article | “ . /

e

HTML The

collection libra ry

Q How did we do it?
We'll show you, clear and simple. Just click the
“Gear icon on every page.

Placeholder with an image (logo) and text
Placeholder with text, functions as the title of the app
Collection Link that links to an InDesign-based article
Collection Link that links to an HTML-article
Collection Link that links to a Collection The Library
Web Link that links to this KB-article!

OOk wN -

Getting started
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< Twixl Publisher Getting Started The Library

FACES MAGAZINE FACES MAGAZINE
Issue Number 1- PDF Issue Number 2 - InDesign

FACES MAGAZINE FACES MAGAZINE
Issue Number 3 - InDesign Issue Number 4 - HTML

@ 304

1. Placeholder with an image (logo) and text
2. Collection Link that links to a Collection with 1 PDF Content Item in Detail Mode
3. Collection Link that links to a Collection in Detail mode, containing several TwixlI

articles

4. Collection Link that links to a Collection in Detail mode, containing several Twixl

articles

o1

Getting started

Collection Link that links to a Collection in Detail mode, containing 1 HTML article
6. Web Link that links to this KB-article!

Page 14
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@ Twixl Sample App

() HMLCollection

@ The Library

@y Main story;

Placeholder with an image (logo) and text

Collection Link that links to a Collection in Detail mode, containing 1 HTML article
Collection Link that links to a Collection The Library.

Collection Link that links to a Collection with an InDesign-article

Web Link that links to a mailto link

Web Link that links to our Privacy Policy

Web Link that links to our Twitter Feed

Web Link that links to our Facebook page

ONO Ok WN

This app has sample content. You can download the original files below. The
InDesign content was created with InDesign CC2020. The HTML content was
created with Blocs.app but you can use any other tool to create HTML.

Faces Magazine 1 (PDF)

Faces Magazine 2 (InDesign)
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Faces Magazine 3 (InDesign)
Faces Magazine 4 (HTML)

+ Styling: Custom Fonts

« Styling: Grid Styles

 Styling: Item Styles
+ Hamburger Menu

« The Browser Client
+ Managing content downloading
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Sample App 02: A Kiosk App

This article explains the concept of our Kiosk app. It's ideal if you want to create a
traditional kiosk app.

The purpose of this sample app is to demonstrate how to create a traditional Kiosk App.
The app is meant to just give you an impression, it is neither a real nor a finished project.
It's a kiosk app with PDF Content Items, a Hamburger Menu and support for the Browser
Client in addition to iOS and Android.

A LEGALINFO:
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This app and its contents can be used for demonstration purposes only. It
cannot be used for other commercial purposes without prior consent from TwixI
media bv.

- Disclaimer
+ General Terms & Conditions

¢ Please remember that you can play around with this app, and change any
settings!

* It has a Hamburger Menu

+ It has the Browser Client activated

+ It has different Browse Grids & Item Styles

« It has several types of content mixed in the app.

« It supports downloading of content for offline access.
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X Demo app - Kiosk [:B

This month:
MAGAZINE #1
File type: PDF

MAGAZINE #2 MAGAZINE #3
Type: InDesign Type: HTML

ﬁg How did we do it?

1. Banner highlighting your brand or baseline. Can also be an image (logo) and text
that links to a website. You could also use an Inline or Embedded Web Viewer, if you
want to implement a Web Banner.

2. Featured Issue:is a Collection Link with text and an image that links to a PDF Content
Item.

3. Legacy issues: linking to InDesign and HTML content.

+ Styling: Custom Fonts
+ Styling: Grid Styles

+ Styling: Item Styles

+ Hamburger Menu

« The Browser Client

« Managing content downloading
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Gathering Content

Twixl Publisher lets you use different content types in your app.

In addition to InDesign-based content created with the Twixl Publisher plug-in, or PDF
files, you can also publish HTML articles.

You can combine InDesign, HTML and PDF content within the same app.

HTML

v
N

PUBLICATION

B

Getting started Page 20
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For detailed information on how to create your interactive InDesign content, check this
chapter.

HTML content can be created manually, using such tools as Adobe Animate or Tumult
Hype, or can be pushed from an external source like WoodWing Inception, WoodWing
Aurora/Studio, Canvasflow, or basically any type of CMS, like WordPress or Drupal.

You can upload simple .html files or a zipped set of HTML files, with the associated assets,
JavasScript, etc. When processing a zipped HTML article uploaded to the platform, we'll
look for an index.html file at the root level. If there is no index.html, but only one .html file
at the root level, then this will be considered the index.html.
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https://twixlmedia.zendesk.com/hc/en-us/articles/115000707609-integration-api
https://twixlmedia.zendesk.com/hc/en-us/articles/115000707609-integration-api
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Plain PDF files can be uploaded for inclusion in your app. Make sure to prepare the PDF
according to the instructions in a this article.

For a full overview of all kinds of content that can be added to a Twixl app, please check
the article Working with Content Items.
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Getting Started in InDesign

Before opening InDesign, make sure you have installed the Twixl Publisher plug-in
according to these instructions.

When you have started InDesign, select the Window menu, then navigate to Extensions
-> Twixl Publisher to open the palette. You will notice a number of options are available in
the palette.

If no object is selected in InDesign, the publication management options will be available.

If a certain object (like a movie or image) is selected, depending on the type of object,
the relevant options for different interactive elements will be displayed.

¢ Twix| Publisher 15.3

Publication Article

Properties Publication

Preview Publication Article

Publication Article

Publication Article

Separate Articles

Alternate Layouts

Preferences

Twixl Publisher offers two different approaches to creating your content:

1. Article-based

Getting started Page 23
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Create individual articles that can be uploaded to a collection on the Twixl platform -
this works best when multiple designers are working on content for the same app, or
when you have an app with frequently updated content.

2. Publication-based

Create a complete publication, using an InDesign book to manage the different
articles - this works best if only one designer is working on the publication. When
importing a Twixl publication to an app on the platform, it will automatically be split
into a collection with individual articles for each of the InDesign documents.

You can decide to create and export individual articles separately. When you export an
article, the exported file will have the extension .article.

Just zip that .article file, and it can be uploaded to the platform.

For more details about adding content to your app, please check Working with Content
ltems.

Twixl Publisher supports 4 different sizes, each of them in landscape and portrait:

- iPad (1024x768 and 768x1024 pixels)

« Android 10 inch (1280x752 and 752x1280 pixels)

« Android 7 inch - Kindle Fire (1024x552 and 552x1024 pixels)
+ Phones (568x320 and 320x568 pixels)

For iPad reting, a scaled 2048x1536 and 1536x2048 version will automatically be
generated when exporting. For phones, 3 renditions will be generated.

New articles or publications created by the Twixl Publisher plug-in will use a specific
naming convention for the alternate layouts:

« iPad: "iPad H' for landscape and “iPad V" for portrait

« Android 10 inch: "Android 10" H" for landscape and "Android 10" V" for portrait

- Android 7 inch: "Kindle Fire/Nook H" for landscape and "Kindle Fire/Nook V" for portrait
« Phones: "Phone H' for landscape and "Phone V' for portrait

@ IMPORTANT NOTE:

If you create documents manually, i.e. by selecting New Document from the File
menu instead of using the plug-in's ‘New article’ menu option), make sure your
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alternate layouts use the naming convention above, and that your documents
have the page size Twixl Publisher expects. If you have layouts with a different
name, you'll receive an error message durning preflight.

Publication Properties

Name | AvantGand
TOC Viewer Title Bar Button
Initial Article
Template iPad Landscape
File Name | Table of Contents
Title

Tag Line

Show Templates Folder...

Select "New Publication”. Once you select a publication name and optional issue number,
the plug-in will create a "book” in InDesign.

An InDesign book file is a collection of documents that can share styles, swatches,
master pages, and other items.

There are two options for displaying your Table of Contents (TOC):

« Title Bar Button (default)
« If you do not want to display a TOC viewer at all, select the option "None®

If you choose "Title bar button..” a TOC icon will appear in the right corner of the title bar,
that will become visible when tapping anywhere on a page of your publication. If you
also defined a hamburger menu in your app, it will appear to the left of that menu.
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Hospitality special

INTRO

% HOTELROOMS
@ WELLNESS

CONFERENCE AND MULTIFUNCTIONAL AREAS
@ BAR AND RESTAURANT

i @ OUTDOOR AREA

[
VELTRIESS JBESTRI

Initial article

Here, you can already create the first article of your publication, as well as select its title
and optional tagline (these will be displayed in the TOC Viewer).

You can also select your starting template. The template you select for your first article
will become the default template for that publication.
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Getting started with the Twixl macOS App

With the Twixl macOS App you can start building the app you have prepared and
designed on the Twixl Platform. You can also preview your app or invite someone else
to preview it.

The steps below describe how to use the Twixl macOS App. The multi-step process is
described in several articles. Below we explain how to install the required
components, how to setup your Twixl Platform account and how to setup Xcode

properly.

The Welcome screen explains how to setup your account.

TI.IJIXL PUBLISHER

Welcome to Twixl Publisher

This app can be used to Preview, Share and Build Getting Started,..o
the projects that you created on the TwixI
platform.

Add your Twixl account to see your Twix| Add Account e
projects here.

To build an app for iOS or Android, you have to
add one or more build settings to the project on
the Twixl platform.

We found legacy build settings locally, that can
be uploaded to the TwixI platform.

Show in Finder...

Close

1. Getting Started: guides you to the Twixl Help pages.
2. Add Account...: click here to add your account (see Add your Twixl account ). Here you
can also select the components pop-up (see below).
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You can access the components pop-up via:

—
.

Twixl Publisher > Preferences > Components

2. Welcome > Add Account > Components

3. Via the warning at the bottom left of the window that appears if something is missing
to build your app.

[ ] Components
Components Accounts
L3
In order to use Twixl Publisher, a number of components need to be installed on your computer. ?
Twixl Publisher plugins for Adobe InDesign Twixl Publisher Helper
Plugin is not installed Helper is not installed
Install Plugin 15.3 Install Helper 15.3
Apple iOS SDK & Xcode Android SDK
iOS SDK 14.5 is installed Android SDK 20200915-1723 is installed

The macOS app lets you install 4 extra components:

1. Twixl Publisher plugins for Adobe InDesign: only required if you intend to create
InDesign-based content with interactive elements

2. Twixl Publisher Helper: required to export and preview InDesign-based content, and
also required to build and preview Twixl Apps

3. AppleiOS SDK & Xcode: required to build iOS apps

4. Android SDK: required to build Android apps

To install these components, open the Preferences... screen in the Mac App (cvp + , )
and install the required components.

Q¢ INSTALL ALL COMPONENTS:
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To avoid problems and unexpected behaviour, we strongly advise you to install
all available components.

In order to build and preview Twixl apps via the macOS App, you need to have an
account on the Twixl platform. There are 2 types of Twixl accounts that will work:

« Administrator
« App Administrator

For more info on how to create accounts on the Twixl platform, see this Help-article.

o bk~ wbhN —~

Twixl Accounts

» 1
Twixl media

To add a Twixl account in the macOS app:
Open the Preferences... Screen

Select the Accounts tab

Click on the + Icon

Fill in your credentials and Sign In

Accounts

@ @

Components Accounts

User

Username: ‘@twixlmedia.com
E-mail Address: t@twixImedia.com

Role: ¢

Account

Twixl media - ID:
Active Subscription
gxpires on 19 Jan 2069

License Key:

Getting started
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If you want to preview or build a Twixl iOS app, you also need to have Xcode installed. The
new macOS App uses a much more simplified approach, so building your Twixl apps will
e easier than ever! To get started, you need to:

1. Install the latest version of Xcode

2. Launch Xcode just once and install the additional required components

3. Add your Apple Developer account ID in the Accounts tab in Xcode's Preferences...
window

4. Make sure a version of the Command Line Tools (CLI) is selected in the Locations tab
of the Preferences... window

Install additional required components?

Xcode requires additional components to support running and
debugging. Choose Install to add required components. '

o (EEIN

a2 o~
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@ c@twixImedia.com @ Apple ID
Apple ID: @twixlmedia.com
Description: @twixImedia.com
L3
Team Role
User
Account Holder
Download Manual Profiles Manage Certificates...
+ — @

Locations Custom Paths

<

Derived Data: Default
© Advanced...

<

Archives: Default

Command Line Tools:  Xcode 12.5 (12E262) o}
]

Before you are ready to finally build your app, there are two important steps to go
through:
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« Configure a build setting for your app on the platform.
« Create a signing certificate in Xcode.

Then you are ready to build your app.

¢ These articles may be relevant for further reading:

- 10S app build types
« Google Play app signing
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Software Installation
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System Requirements

Adobe InDesign from CC2015 and up on macOS or Windows.

The Twixl Publisher application requires macOS Monterey 12.x or higher.

Xcode

7/\ v

% /,-

4 Developer Tools
OPEN

2.8

* * X

What's New

Xcode 14.2 includes SDKs for iOS 16.2, iPadOS 16.2, tvOS 16.1, watchOS 9.1, and macOS Ventura
13.1.

Preview

HE0eSC08EP@0 - 0NORONE B HE0e=E808EPB0-0NORONE B

Mac

Xcode will allow you to get a preview of your application in the iOS simulator on macOS.
The components panel of the macOS app will alert you if it needs to be installed or

updated.

« Xcode is a free download from the Mac App Store

* In order to create app builds that can be installed on a device, or to submit apps in
the App Store, you need at least Xcode 14 and need to be registered as a developer in

the "iOS Developer Program’ (99$/yr): Start here to enroll now.

Getting started
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« Android SDK: the Android SDK needs to be available to create Android builds.
The System Check in preferences allows you to check for the presence of the Android
SDK and offer to install it if it's unavailable, or update it if a newer release is available.

« In order to submit Android apps in the Google Play store, you need a Google Play
account.

Below is an overview of the different OS and app versions that are supported by Twixl
Publisher.

(refers to the OS versions required to install the apps on those devices)

* i0S: 14.x or higher
« Android: 7.x or higher

(refers to the versions required for creating app builds)

* macOsS: 12.x or higher

« Xcode: Xcode 14.x or higher for building and submitting apps (to support the latest iOS
versions and devices, you should always us the latest version).

A MPORTANT NOTE:

To submit mobile apps (.ipa) to the App Store, you need the Transporter App. See
this article.
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Installation

First download from our downloads page, then copy the Twixl Publisher.app from the disk
image to your Applications folder. When opening this app, you will be prompted to install
or update the InDesign plug-in if it has not been installed yet, or if it needs to be updated.
The plug-in will then become available in InDesign from the menu Window -> Extensions.
You also need to install the Twixl Publisher Helper.

In order to build iOS apps, Xcode needs to be installed. For Android, the Android SDK
needs to be downloaded.

[ ] Components

wr

Components Accounts

L3

In order to use Twixl Publisher, a number of components need to be installed on your computer. ?

X X

Twixl Publisher plugins for Adobe InDesign Twixl Publisher Helper
Plugin is not installed Helper is not installed
Install Plugin 15.3 Install Helper 15.3
Apple iOS SDK & Xcode Android SDK
iOS SDK 14.5 is installed Android SDK 20200915-1723 is installed

Double click the Twixl Publisher.exe installer to install the plug-in for all supported
versions of InDesign that are installed on your system.

The plug-in will become available in InDesign from the menu Window -> Extensions.
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Check for updates...

® Twixl Publisher File Edit Tools Window Help

About Twixl Publisher

Preferences...
Check for updates... N
Services >

Hide Twix| Publisher
Hide Others
Show All

Quit Twixl Publisher

When the Twixl Publisher macOS app starts up, it checks whether an update for the
application is available.

If an update for the app itself is available, it will display the release notes and offer to
download it.

You can also manually select "Check for updates...” from the Twixl Publisher application
menu.
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[ ] Components

wr ®

Components Accounts

L3

In order to use Twixl Publisher, a number of components need to be installed on your computer. ~ ?

X X

Twixl Publisher plugins for Adobe InDesign Twixl Publisher Helper
Plugin is not installed Helper is not installed
Install Plugin 15.3 Install Helper 15.3

v v

Apple iOS SDK & Xcode Android SDK
iOS SDK 14.5 is installed Android SDK 20200915-1723 is installed

When the Twixl Publisher macOS app starts, it also checks the status of several
components, and will report if a component needs to be installed or updated.

It will display information about the following checks:

« Whether the Twixl Publisher plug-in is up-to-date, and if it is not, you can update it

« Whether the Twixl Publisher Helper background application is up-to-date, and if it is
not, you can update it

« Whether the i0S SDK (part of Xcode) is installed (required for iOS simulator previews
and app builds) - if it's not, the "Install” button will link to Xcode in the Mac App Store

« Whether the Android SDK is installed (required for Android app builds) - if it's not, the
“Install” button will allow you to download it

If all components are up-to-date, the Twixl Publisher app will automatically go to the
main screen.
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Licensing information

If you purchase a Twixl Publisher subscription, the license is managed on the Twixl
platform. When your subscription is processed, we'll send you a separate email that
contains your Twixl License Key. The mail will also contain instructions on how to activate
your License Key on the Twixl platform.

Home » Account: Twixl media

Account: Twixl media Region: Europe * Account ID: 2

Subscription Support

Your local partner: Twixl media Direct

A t g
T:IE;?.;Z g;”:szrs . Please note that the access to this account will be handled confidentially and will be used only

for the purpose of examining and solving your support questions. The account shall be
accessible for the members of our support team only.

Allow the Twixl media Support team to access the information in this account.

Email: sales@twixlmedia.com

Subscribed user
Expiration date: 18 jan 2038 For more info about the Support Access functionality, see this info
Twix| Publisher - Unlimited Multi with Pro Pack - yearly subscription (legacy)

# Production Apps: Unlimited

License Key
45LH8PMS

Replace License Key

Once you have activated a license on the Twixl platform, you can activate your macOS
App as well. This is done by adding an active User Account to the Mac App. More info on
how to activate User Accounts can be found here.
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Downloads
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Downloads

Downloads
 Twixl Publisher for macOS consists of an application that allows you to build your iOS
and/or Android apps, and also lets you install the Twixl Publisher plug-in for InDesign.
 Twixl Publisher for Windows will install only the Twixl Publisher plug-in for InDesign.
« Build Twixl apps for iOS & Android (on a Mac)
+ Preview the result on your tablet or phone
« Share your articles/publications with colleagues and clients

# Download on the 5 GETITON

| App Store B\ Google Play
# Download on the R GETITON

¢ App Store ;\ Google Play

+ The Twixl app lets you preview your complete app in real time on your device, and

lets you share it with others.
+ Twixl Viewer Classic lets you preview content from InDesign with the Twixl Publisher

plug-in.
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TI.IJIXL DISTRIBUTION PLATFORM

« On the Twixl Distribution Platform, you can create a sample app (or a completely new
empty app and define its interface from scratch), preview your app’s content and
share it with others.

« During your 30-day trial, all extra paid options like the Entitlement Pack, Integration API
and Automated Content Sources are enabled by default, so you can play around with
these features if you wish.

Release Notes

These are InDesign files with samples of the different interactive features.

Example Files

Here you can find the downloads to some older releases of Twixl Publisher.

Older versions
IMPORTANT: Please note that version 11.6 should only be used under the following
circumstances:

« you dre running a version of macOS older than 10.15.

« you want to create a Web Reader export of your InDesign content. note that the
Browser Client is a more complete alternative.

+ note that this version will expire for use on January 18, 2024.
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Release Notes

Release notes
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PDF Manuals

¢ LATEST UPDATE:

2] February 2023

Here you can download a PDF of the main chapters in our documentation.

Getting Started

Create your interface

Create in InDesign

Build your app

Manage your app

Distribute your app

Advanced Features

Migrating from Adobe

Advanced Features (Custom URL Schemes, Advanced Scripting, etc.)
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